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Excel 2003 
Use Excel to turn the SOLAR Class Roster 

Download into an Electronic Grade Book and 
Attendance Roster 

 
Make the Most of a Class Roster Download 
 
Getting Started with Microsoft Excel 2003 
 
Save yourself some time, energy and keystrokes.  Learn how to use MS Excel to 
make the most of the class roster download available in SOLAR Faculty 
Services. Turn your download into an electronic grade book and attendance 
sheet. 
 
This guide will help you learn some of the basic functions of Microsoft Excel by 
understanding the basics of spreadsheet functions, capabilities, and the tools 
necessary. 
 
Utilize the class roster downloaded from the SOLAR system as a great place to 
start in creating an electronic grade book and attendance roster.    
 
Table Of Contents 
 

1. How to Download the SOLAR Class Roster  

2. Getting Started - Launching Your Excel Application  

3. Workbook Basics  

 What is a Workbook 

 What is a Worksheet 

 The Workbook Window 

 The Worksheet Window 

4. Turn your Download into an Electronic Grade Book 
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Download the Class Roster From SOLAR 
 
How to Download the Class Roster from SOLAR 
 

1. From the Web Portal Page click on the Services for Faculty & Staff link 
under the My Menu Options. 
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2. Click on the Class Roster Download link. 
 
 
 
 
 
 
 
 

The Schedule of Classes Download page displays. (See figure below) 
 

3. Click the Run button. 
 
 
 
 
 
 
 

 
The Class Roster Download page displays. 
 
 
 
 
 
 
 
 
 
 

4. Term Field - Use the Lookup button and select the appropriate term, or 
enter the four-digit term code in the Term field. 

 
5. Session Field - Use the Lookup button and select the appropriate 

session number. (1 = Regular Session - Fall and Spring is most commonly 
used number.) 

 
6. Class Number Field - Enter the five-digit Class Section number (ticket 

number). 
 
7. Click the View Results button. 

Enter appropriate data. The Lookup 
icon can be used for the Term and 
Session fields. 

Click the View Results button. 
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The class roster displays. 

 
 
 
 
 
 
 
 
 
 

 
8. Select the appropriate Excel Spreadsheet link for your computer. 

 
If using a PC: 

• A window will pop up asking if you want to “Open” or “Save As”.   
• Select Save As and then identify where you want the document to 

be stored on your computer. 
 
If using a Macintosh: 

• The download manager will automatically download the document 
to the preference identified folder. 

 
Open the class roster in Excel. 
 
Sample of a class roster download. 

 
 
 
 
 
 
 
 
 
 
 
 
 
The file downloads a workbook which contains all of the information from the 
class roster. Each piece of information is in its own column.  By utilizing the 
download you can pick and choose which information you wish to keep for 
your record keeping.  

 

Select appropriate Excel  
Spreadsheet link.
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Getting Started 

Launching Your Excel Application 
1. To launch your application: 

• PC Users - Click the Start icon button on the Taskbar at the bottom 
left corner of your screen. 

 
• Point to Programs. 

 
• Click the Microsoft Office selection from the submenu, and then 

select Microsoft Excel. 
 
The application will launch and open. 
 

• Mac Users - Click the Excel icon from you taskbar 
 

The application will launch and open. 
 
Workbook Basics 
 

Excel is a spreadsheet program. Spreadsheet programs have the ability to 
perform an assortment of functions.  These programs use worksheets and 
workbooks.   

Understanding the Excel Environment 
What is a Workbook? 
A workbook is a file that contains worksheets. A single workbook can contain 
many, many worksheets.  It is the normal document or file type in Excel.  It is 
the electronic equivalent of a three ring binder. 
 
What is a Worksheet? 
Think of a worksheet as a page within a binder.  A worksheet is divided into a 
grid of columns and rows in which you input your data, as seen on the class 
roster download example. 
 
The Workbook Window 
An Excel workbook window is shown in Figure 1. 

The Worksheet Window 
The worksheet window displays the Excel worksheet. It is comprised of rows 
and columns. The columns are labeled with the letters of the alphabet, i.e., A, 
B, C, etc. The rows are numbered down the left side. Rows and columns 
intersect to form cells. Each cell can be referenced via its column name 
followed by its row number. For example, the intersection of row 2 and column 
B is cell B2 (as shown in Figure 1). 
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Figure 1 - The Excel Workbook Window 
 

 

 
 

 
 

 
 

 
 
 
 
 
 
 
 
 
 

• Menu Bar. The Menu Bar at the top of the screen gives you access to 
different commands that are used for such tasks as opening and 
closing files, printing documents, formatting data, and other operations.  

• Toolbars. On the sample window in Figure 1 (above), immediately 
below the Menu Bar is a row of icon buttons called the toolbars. There 
are two toolbars that provides quick access to a number of the most 
commonly used Excel features. The first bar is the Standard Toolbar; 
the second is the Formatting Toolbar.  By positioning the mouse 
pointer on a toolbar icon (without clicking), a yellow box will appear 
next to the icon with a brief description of that icons purpose. 

• Formula (or Function) Bar. The Formula Bar displays the contents of 
the active cell or the active block. It includes text, numbers, formulas, 
and functions. 

• A Row - runs horizontal on the worksheet.  Each row heading begins 
with a number i.e. 1, 2, 3, which is found in the far left hand side of the 
worksheet. 

 
• A Column - Columns run from top to bottom on the worksheet.  A 

column heading is identified by the letters A, B, C, etc.  
 

• A Cell - is the intersection of a row and a column and has a unique 
address or reference. 

 
• Active Cell - The active cell is the currently selected cell. A thick 

border block, called the Cell Pointer, surrounds the active cell. Data is 
entered in the active cell. 
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• Active Sheet - Often a file consists of more than one worksheet. Each 
sheet contains a tab you click to move from one sheet to another. You 
can rename sheets to make it easier to remember what each one 
contains. You may do so by double-clicking the sheet name, e.g., 
Sheet1, typing a new name, and tapping the ENTER key. 

Turning the Class Roster Download into a Grade Book 

Turning your download into an electronic Grade Book 

Inserting a blank row 
Insert a blank row just above the student name title. Usually around row 2. 

1. Click anywhere in the row below the location of the row you want to 
insert. 

• i.e. select cell A2 to Insert a blank Row at Row 2 
 
 

2. Click Insert on the Menu Bar, and then click Rows on the sub menu.  A 
blank row will be inserted above the selected cell or row. 

 
Figure 2 – Menu Bar Option 

 
 
 
 
 
 
 
 
 

Note: Inserting a blank column uses the same steps as inserting a blank row 
with the exception of selecting the column where you want to insert and 
selecting Columns from the Insert menu. 
 
3. In the newly inserted row, the first cell in column A type in : 

• The name of your Course, its meeting day and time 
4. In the cell directly below it  type in: 

• The Course class number 
 

Adjusting the format of a cell 
 

5. Select the cell where you typed the course name.   
6. Adjust the format in this cell by: 

• Changing the alignment of the cell to a left align by clicking on the 
Left Align icon on the formatting toolbar. (See Figure Below) 
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Figure 3  
 

 
 
 
 

 
• Next, change the font size to 10 by selecting the Font Size icon on 

the formatting toolbar (see Figure Above). 
 

Making a copy or duplicate of a worksheet 
Next, make a copy of the worksheet. By making a copy of the worksheet, you 
retain the original information and sheet incase you must return to it. To do this, 
follow the steps below. 
 

1. Single click on the active sheet tab at the bottom left of the workbook. 
 
`    Figure 4 – Active Worksheet Tab 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. For PC Users - While holding the left mouse button down also hold the 
Ctrl key down.   

• Behind your mouse pointer arrow a piece of paper will appear with 
a plus (+) sign in it. See below. 

 
Figure 5 – Making a copy of a worksheet 
 
 
 
 

Active Sheet Tab 
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Click on the Create a copy 
box, then click OK 

3. While holding down the mouse button and the Ctrl key, drag the 
mouse to the right.  The small black arrow will move to the right of the 
active tab. 

 
4. Release the mouse button and the Ctrl key. Excel creates an exact 

duplicate of the active worksheet for you. The new sheet is named the 
same as the one copied, however a number in parenthesis has been 
added to the end. 

 
Figure 6 – Excel created a duplicate worksheet 

 
 

 
 
 
 
 
 

• For Mac Users - From the Edit menu, select Move or Copy Sheet 
• The Move or Copy dialog box will appear (see figure 7) 
• Click on the Create a copy box. 
• Click on OK. 

Figure 7 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Excel creates an exact duplicate of the active worksheet for you and 
renames the new sheet. The new sheet is named the same as the one 
copied, however a number in parenthesis has been added to the end.   

 
Change the Title 
 
Next, change the title - Class Roster Download to Class Grade Book 
 

1. Do this by double-clicking in cell A1, where the original downloaded title 
appears, and typing over the existing text. 
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Delete unwanted information from a range of cells 

 
1. Select the range of cells in which you wish to delete the information.   

• I.e. select Cells D5 – through the end of table information 
 

Figure 8 – Selecting a range of cells 
 
 
 
 
 
 
 
 
 
 
 
 

 
2. Select Edit from the menu bar, then Clear > Contents from the 

submenus. (See figure 9 below) 

 
Figure 9 – Menu Bar Option 

 

 
 

 

 

 

 

You now have a basic spreadsheet to work with and can customize to your class 
course requirements. 
 

Entering Data in a Cell 
 
Next, enter your class assignments across the row that currently contains the 
class roster download category headings.  In Figure 8, it would be row 4. Most 
faculty will begin in Column C, making sure to keep the student name and ID 
information.   
 

1. Click on the cell you wish to edit.  In the Figure 8, it would be cell D4.  
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2. Type the class assignment within that cell.  When completed, you 
may use the mouse to point and click on the next cell of simply hit your 
enter key.  

 

In Cell Editing 
 

To edit a cells content follow the steps below. 
 

1. Double-click the cell you wish to edit.  The flashing line pointer appears 
within the cell. 

2. Make corrections or edits to the text within that cell.  You may use the 
mouse pointer or the arrows to position the flashing pointer where you 
want.  You may also use the Backspace or Delete keys to erase unwanted 
characters. 

3. Press the Enter key to accept the edit, or press Esc to cancel the edits. 
 

Deleting or inserting a column 
 

If there are unused columns remaining in your worksheet, or if you do not have 
enough columns, delete the unwanted columns or insert new columns in 
the spreadsheet by following the steps below. 
 

1. In the column headings, click and highlight the range of columns to 
delete or insert. Remember that the column headings begin with A, B, C, 
etc.  

• i.e. Highlight columns C - J to delete 
 
Figure 10 – Selecting a column range 

 
 
 
 
 
 
 
 

 
 

TO Delete:  
 

2. Select Edit from the menu bar and Delete from the submenu to delete 
the unwanted columns. The columns that were selected will be deleted. 

Column heading 
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Figure 11 – Menu Bar Option 

 
 
 

 
 
 
 
 
 
 

TO Insert:  
3. Select Insert from the menu bar and Rows from the submenu.  

 

Changing Column Widths & Row Heights 
 

Sometimes, you may need to manually adjust a column or rows width or height.  
Changing Column Widths 
 

There are several ways to change the width of a column or columns. Excel 
allows you to select a single column or multiple columns at a time. To select 
multiple columns: select the range of columns to affect by clicking on the first 
column and while holding the left mouse button down, drag along the column 
header to highlight the range of columns to affect.   
 

Within the highlighted range of columns, Drag the right-column border 
with the mouse until the column is the desired width.  When the mouse 
pointer is directly over the column border, the pointer will turn to a black plus 
sign with arrows on the right and left. See figure below. 

 
  OR 

 
Double-click the right border of the column header to set the column 
width automatically to the widest entry in the column. 
 



California State University, Northridge                 Information Technology Training Guide 

Prepared by Tina Actis-Purtee, User Support Services          June 14, 2006 
 

ITR’s Technology training guides are the property of California State University, Northridge.  They are 
intended for non-profit educational use only.  Please do not use this material without citing the source. 

 
Figure 12 – Selecting a range of columns 
 
 

 

 

 

 

 

Changing Row Heights 
 

Excel adjusts row heights automatically to accommodate the tallest font in the 
row.  However, you can set the row height manually by using several techniques.  
As with columns, you can select multiple rows. 

 
1. Drag the lower row border with the mouse until the row is the desired 

height.  
                   OR 
2. Double-click the bottom border of the row to set the row height 

automatically to the tallest entry in the row.   
 
To select multiple rows, either click and drag in the row header or press Ctrl 
while you individually select the rows. 
 
Stack Your Type by Inserting a Hard Return in a cell 
 
There are occasions when you will want to stack or insert a hard return in a cell.  
To do this: 
 

1. Double-click the cell you wish to edit.  The flashing line pointer appears 
within the cell  

2. Place flashing pointer at the point where you want to insert the hard 
return. 

3. Select the Alt then Enter key in sequence.      
 
Excel inserts a hard return between the text and stacks your text.  
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Changing the name of a Worksheet 
 
Excel uses a default naming convention such as Sheet1, Sheet2, and so on.  
These are not very descriptive, that’s why providing more meaningful names for 
your worksheets is usually a good idea. 
 
To change a sheet’s name: 
 

1. Double-click the sheet tab 
 

Excel highlights the name on the sheet tab so that you can edit or replace the 
name.  See figure below. 
 
    Figure 13 – Selecting and Renaming a sheet tab 
 
 

 

 
 
 
 

2. Type the new name 
 

Sheet names can be up to 31 characters, and spaces are allowed.  Excel will 
not allow you to use special characters in the name such as / ? * ) etc. 

 
Selecting Non-Adjacent Cells 
 

To make the new worksheet flow easier for your eyes,  select every-other row 
beginning with the first student row, and change the background color of that 
row. This will create a nice horizontal flow for your eyes to flow freely across the 
sheet. To select Non-Adjacent Cells follow these steps: 
 

1. Select the first student row by moving your mouse pointer over 
the row number and left clicking once. If the mouse pointer is in 
the proper location it will turn to a black arrow pointing down the 
row.  (See figure below) 

2. Next, hold the Ctrl key down and click on every-other row of your 
worksheet. Your sheet will look like Figure below. 
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Figure 14 – Selecting Non-Adjacent Cells 
 

 
 

 
 

 
 
 
 
 

 

3. Now, select the Fill Color icon on your formatting toolbar.  Click 
on the small black arrow next to the icon in order to display the 
color palette.  (See Figure below). 

 
Figure 15 

 
 
 
 
 
 
 
 
 
 
 

4.   Choose a color from the color palate by clicking on it. 
5.   Click away from your spreadsheet selection by selecting another                               

cell.  
 

 Your Excel worksheet should look similar to Figure 16 below. 

Pointer changes to black arrow pointing down 
row. 
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Figure 16 –Colorizing Non Adjacent Rows/Cells 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Page Setup 
 

The page setup is very important to the layout and printing of your worksheet.  
You may wish to perform the Page Setup function first, prior to inputting data on 
your worksheet. 
 

1. Select File from the menu bar and Page Setup from the submenu. 
 

Excel will display the Page Setup window. 
(See Figure 17 below) 

 

2. Change the Page Orientation to Landscape. 
3. Change the Scaling “Adjust to” option to 80% 
4. Click OK. 
 
Figure 17 – Page Setup Window 
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Using Functions in you Worksheet 
 

This next section of the guide will take your knowledge one step further by 
showing you how to create an advanced excel formula so that excel will 
automatically calculate the final grade based on information you give it.  This 
information was designed to help make the process of inputting and calculating 
grades for your classes a simpler and less time consuming effort.  
 

Summing Values using the SUM function   
The SUM function is the most widely used function in any spreadsheet program.  
It is also among the simplest.  There are several ways to calculate the sum of a 
range or ranges of data. 
 

Using AutoSum 
Excel’s AutoSum feature makes it very easy to quickly sum a group of values.  
Using the electronic grade book we created in the first section, we have rows of 
student data and the points that students earned on each assignment. See 
Figure below. 
 Figure 1 
 
 
 
 
 
 
 
 

Calculating Totals 
 

1. In the total point’s column of the spreadsheet, select the first cell 
where you want a total calculation to appear. i.e. Cell O5 in figure 
below. 

 
Figure 2 
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Excel AutoSum formula calculation 

2. On the standard toolbar, select (by clicking on the icon one time) the 
AutoSum icon.     

 

 
A scrolling line appears around the cells that Excel is capturing in the formula.  
Excel will automatically develop the proper formula format.   
 
 Figure 3 
 
 
 
 
 
 
 
Next, use the AutoFill function to copy the newly formed formula down the 
column so that you do not have to repeat the process of clicking on the 
AutoSum icon for each row.  See below for instructions. 
 

Using the AutoFill Function 
 

Excel’s AutoFill feature makes it easy to insert a series of values or text items in 
a range of cells.  It uses the AutoFill handle (the small box at the lower left of the 
active cell).  You can drag the AutoFill handle to copy the cell content or 
automatically complete a series.   
 

1. Select the cell in which the AutoSum formula appears.   
2. In the bottom right corner of the highlighted cell you can see a small 

square.  This is the AutoFill handle. See Figure below. 
 

Figure 4 
 
 
 
 
 

3. Select the AutoFill Handle.  To do this, move the mouse pointer over the 
AutoFill Handle.  The pointer will change to a small black plus (+) sign. 
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Figure 5 

 
 
 
 

4. While holding the left mouse button down, drag the AutoFill Handle 
down the column to the last student row.   

 
Excel will automatically continue the formula pattern and change the reference 
to the correct row. 
 

Creating a Basic Lookup Formula 
 
You can use Excel’s basic lookup functions to search a column or row for a 
lookup value to return another value as a result.  
 
Looking up a value in a column using VLOOKUP 
(Returning the Final Grade) 
 
The VLOOKUP function looks up the value in the first column of the lookup table 
and returns the corresponding value in a specified column of the matching row.  
The values in the lookup table are arranged vertically. The syntax for a 
VLOOKUP function is: 
 
  =VLOOKUP(lookup_value,table_array,col_index_num,range_lookup) 
 

1. Create a column after the Total Points column on your spreadsheet 
named Final Grade. See figure 6 below. 

 

2. In a NEW column to the right of the Final Grade column, input the 
grading scale to be used.  

 

• **  IMPORTANT **  Remember that each number and letter grade 
must be in its own cell.  They cannot be combined in a cell. 

• Grade scale must be in ascending order only. 
 

Mouse pointer turns to 
a plus (+) sign. 
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Highlight only those cells that contain  
the Grading Scale information 

Figure 6 
 

 
 

 
 
 
 
 
 
 
 
 
  
         

3. Next, Highlight the range of cells that contain the 
Grading Scale. Figure 7. Using the example above that 
would be cells R5 through S15.   

Figure 7 
 
 
  
 
 
 
 
 
 
 
 

 
 

4. While the selection is highlighted, select the Name Box from the function 
toolbar. See figure 8 below. 
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Figure 8 

 
 
 
 
 
 

5. Name the table range by typing in the name Grades. Be sure to hit the 
Enter key when done typing in the name. 

6. Now, in the new Final Grade column of the spreadsheet, select the 
first cell where you want a grade to appear. Using example Figure 6 
that would be cell location P5.    

7. Type in the VLOOKUP formula.  
• Begin with an = sign 
• Type Vlookup 

• Type open parenthesis ( 
• Type the cell location where the Total Points appear for your first 

student and end it with a comma , 
• Type the name of the grade scale i.e. Grades, be sure to put a 

comma after the name 
• Type the number 2. The number 2 refers to the second column in 

your grade scale table. 

• Type close parenthesis ) 

 
Using Figure 6, the vlookup formula would look like:     
=VLOOKUP(O5,Grades,2) 
See Figure below. 

 

8. Select the Enter key to accept the formula. 

Function Bar Name Box 
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Excel will automatically gather the score from the total points column and 
lookup the score in the table we named “Grades”.  It then returns the 
Grade indicated in the table for that score and puts it in the Final Grade 
column.  

Figure 9 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

9. Next, Copy the formula down the spreadsheet using the AutoFill 
technique. 

 

You now have a complete electronic grade book.  Congratulations!! I hope you 
find this lesson in Excel valuable. 

 
Creating a Template  
 

Creating a Worksheet Template  
 
Creating a template will save you time and energy.  You have just spent time 
creating a class grade roster, formatting the page to be the way you want it to 
look, creating formulas to follow, and assigning your class assignments so now 
let’s not waste anymore time having to do it again.  Create a template from the 
worksheet you just created by following these steps below: 

 
1. Make a copy of the worksheet you have just completed. 
2. Rename the new sheet “Class Grade Roster Template”. 
3. Now, in this new worksheet, select all cells containing student 

pertinent information only.  For example, using figure 9 on the prior 
page, select cells A5 through N15. Be sure not to select those cells that 
we have inserted formulas.  (The Totals Points column and the Final 
Grade column). 
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4. Clear the contents of this highlighted range of cells by choosing the Edit 
menu, then Clear > Contents. 

 

You now have a blank grade roster to use for the other classes you teach.  
 

 Proceed through the class roster download process for each of the 
classes you teach.  

 

 Utilize the class grade roster template to make a class Grade roster for 
each of your classes.  To do this follow these steps: 

 

1. Make a copy of the Grade Roster Template 
2. Rename the copy for the class you will be utilizing it for.  i.e. Comp 100, 

Sat. 9:00am 
3. Open the Class roster download worksheet. 
4. Select the cells that contain the student information you wish to copy to 

the Grade roster.  i.e. Student Names and Student ID’s. See figure 10 
below.                            

Figure 10 –  
Selecting Student Info 
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5. From the Edit menu, select Copy. 
6. Select the new worksheet. 
7. Select the first cell in which the student information is to appear.           

i.e. cell A4 
8. From the Edit menu, select Paste Special.     Excel displays the Paste 

Special dialog box as seen in the figure 11 below.  
9. Change the Paste item from All to Values by clicking on the circle in 

front of Values.  
Figure 11 – Paste Special Dialog Box 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

10. Click the OK button 
 

Excel inserts the copied cells into the new worksheet but does not change the 
format of the cells. 
 

Creating an Attendance Worksheet 
 

You have learned how to edit the class roster and turn it into an electronic grade 
book, and duplicate a worksheet.  Now we will work with the duplicate worksheet 
to turn it into an attendance sheet.  Since we have already gone through a whole 
process to format the grade roster worksheet will use the work we have done to 
save us time in creating this Attendance Worksheet. 

 

1. Create a copy of the Grade Roster class sheet. 

Click on the 
“Values” circle. 
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2. Rename the sheet “Class Attendance Sheet”. 
3. Clear the contents of the cells not to be utilized. Keep only the 

students name and ID number.  For example, begin with the first 
students’ scores and select through the last student and the very last 
column with information in it in the worksheet. See Figure 1 below. 

 

Figure 1 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Now we can begin altering this worksheet and turning it into an 
attendance worksheet. 

 
4. Begin by typing in the column category headings such as the class 

meeting dates. 
   
    
 Figure 2 
 
 
 
 

5. Highlight the cells with the dates. 
6. From the Format menu, select Cells. 
7. Select the Number tab from the Format Cells dialog box. See figure 3 

on next page. 
8. Under Category, select Date option. 
9. Under Type Options, select the date option you wish to appear.    
10. Click the OK button.  

Type the month and 
day in each category 
heading. 
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Figure 3 –  
Format Cells Dialog Box 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
Changing Column widths  
 
See “Changing Column Widths and Row Heights” for detailed instructions on 
how to change Column widths. 
 

1. Highlight the columns range that contains the class dates.       
2. Drag the right-column border with the mouse until the column is 

the desired width.  
 

Entering Data in a Cell 
 

Change Worksheet Title in Cell A1 
 

1. Double-click the cell you wish to edit.  The flashing line pointer 
appears within the cell. 

2. Make corrections or edits to the text within that cell.  Suggested 
Title: Class Attendance Roster.  You may use the mouse pointer or 
the arrows to position the flashing pointer where you want.  You may 
also use the Backspace or Delete keys to erase unwanted 
characters. 

Category 
Options 

Number Tab 

Type Options 



California State University, Northridge                 Information Technology Training Guide 

Prepared by Tina Actis-Purtee, User Support Services          June 14, 2006 
 

ITR’s Technology training guides are the property of California State University, Northridge.  They are 
intended for non-profit educational use only.  Please do not use this material without citing the source. 

3. Press the Enter key to accept the edit, or press ESC to cancel it.  
 
Page Setup 
 
The page setup is very important to the layout and printing of your worksheet.  
You may wish to perform the Page Setup function first, prior to inputting data on 
your worksheet. 
 

1. Select File from the menu bar and Page Setup from the submenu. 
 

Excel will display the Page Setup window. 
 
 Figure 4 – Page Setup Window 
 

 
 

 
 

 
 
 
 
 
 
 
 
 
 

2. Change the Page Orientation to Landscape. 
3. Change the Scaling option to 90%. 
4. Click OK. 

 
You now have an Attendance Roster for your class.   
 
* NOTE * Utilize the same steps  in “Creating a Template” to make a Class 
Attendance Roster Template to utilize for each of your classes.  

 
 

 

Landscape Option

Scaling Option


